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Class 1 Laser Product
Any service to this product must be carried out by Extron and its qualified service personnel.

CAUTION:	 Using controls, making adjustments, or performing procedures in a manner 
other than what is specified herein may result in hazardous radiation exposure.

NOTE:	 For more information on safety guidelines, regulatory compliances,  
EMI/EMF compatibility, accessibility, and related topics, see the “Extron Safety and 
Regulatory Compliance Guide” on the Extron website. 

Complies with 21 CFR 1040.10 and 1040.11.

Produit laser de classe 1
Si ce produit a besoin d’un quelconque entretient, celui-ci doit être fait par Extron et son 
personnel qualifié.

ATTENTION :	 L’utilisation de commandes, la réalisation de réglages, ou l’exécution 
de procédures de manière contraire aux dispositions établies dans le présent 
document, présente un risque d’exposition dangereuse aux radiations.

Remarque : 	 Pour plus d'informations sur les directives de sécurité, les conformités 
de régulation, la compatibilité EMI/EMF, l'accessibilité, et les sujets en lien, consultez le 
« Informations de sécurité et de conformité Extron » sur le site internet d'Extron.

Conforme aux section 1040.10 et 1040.11 du titre 21 du Code des règlements 
fédéraux des États-Unis.



Conventions Used in this Guide

Notifications
The following notifications are used in this guide:

DANGER:	

•	 Will result in serious injury or death. 

•	 Entraînera des blessures graves ou la mort.

 WARNING:		  Potential risk of severe injury or death. 

AVERTISSEMENT :	 Risque potentiel de blessure grave ou de mort.

CAUTION:		  Risk of minor personal injury.

ATTENTION :	 Risque de blessure mineure.

ATTENTION:	

•	 Risk of property damage. 

•	 Risque de dommages matériels.

NOTE:	 A note draws attention to important information.

TIP:	 A tip provides a suggestion to make working with the application easier.

Software Commands
Commands are written in the fonts shown here: 

^AR Merge Scene,,0p1 scene 1,1 ̂ B 51 ̂ W^C.0
[01] R 0004 00300 00400 00800 00600 [02] 35 [17] [03]
E X! *X1&* X2)* X2#* X2! CE}

NOTE:	 For commands and examples of computer or device responses used in this 
guide, the character “0” is the number zero and “O” is the capital letter “o.” 

Computer responses and directory paths that do not have variables are written in the font 
shown here: 

Reply from 208.132.180.48: bytes=32 times=2ms TTL=32
C:\Program Files\Extron

Variables are written in slanted form as shown here:

ping xxx.xxx.xxx.xxx —t
SOH R Data STX Command ETB ETX

Selectable items, such as menu names, menu options, buttons, tabs, and field names are 
written in the font shown here:

From the File menu, select New.
Click the OK button.

Specifications Availability
Product specifications are available on the Extron website, www.extron.com.

Extron Glossary of Terms
A glossary of terms is available at https://www.extron.com/technology/glossary.aspx.
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Introduction

This section provides an overview of this guide and the features of the Extron AXI 02 AT 
Audio Expansion Interface. This section covers the following topics:

•	 About this Guide

•	 About the AXI 02 AT

•	 Features

•	 Applications Diagrams

About this Guide
This guide contains installation, configuration, and operation information for the Extron 
Electronics AXI 02 AT audio expansion interface. In this guide, the terms “AXI device,” 
“device,” and “AXI” are all used to refer to the AXI 02 AT interchangeably.

About the AXI 02 AT
The AXI 02 AT audio expansion interface is a Dante-to-analog converter in a 1U high, 
eighth‑rack width zip-clip enclosure. The AXI 02 AT is a Dante input, analog output interface 
with an additional S/PIDF digital output. Analog outputs accept 3.5 mm captive screw 
connectors. The RJ-45 PoE port on the front panel of the device provides two Dante 
receiver channels and powers the device. Output attenuation and device settings are 
configured with Extron DSP Configurator Software or SIS commands through DataViewer 
or other control software. The AXI advertises itself on the Dante network and uses the 
Dante Controller software for routing, device naming, channel naming, transmission latency, 
sample rate, and IP communication settings.

NOTE:	 The AXI 02 AT may also be powered with an external power injector.

Features
•	 Receives two audio channels from a Dante® network — Two channels of high 

quality digital audio can be routed from the Dante network and converted to balanced 
or unbalanced line level analog audio on a captive screw connector.

•	 Mirrored two-channel analog and S/PDIF audio outputs — Audio is 
provided as two line level analog outputs on captive screw connectors and a mirrored 
two‑channel S/PDIF output on a coaxial RCA connector.

•	 Studio grade 24-bit digital-to-analog conversion with selectable 
sampling rates up to 96 kHz — Professional converters fully preserve the integrity 
of the original audio signal with selectable sampling rates via Dante Controller.

•	 Power over Ethernet — Allows the AXI 02 AT to receive power and audio over a 
single Ethernet cable, eliminating the need for a local power supply.

•	 1U, eighth rack width enclosure, ZipClip™ 100 included — Compatible 
with Extron Rack Shelves and ZipClip mounting solutions.
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•	 Software adjustable analog output attenuation — Compensates for 
downstream level requirements using SIS commands via USB or DSP Configurator.

•	 Dante audio networking provides a wide range of expansion 
capabilities — Dante-equipped audio products, including the AXI 02 AT, provide 
scalability for creating larger audio systems over a local area network using standard 
network protocols and hardware.

Applications Diagrams
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Figure 1.	 AXI 02 AT Application Diagram

1  
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Installation and 
Operation

This section describes the AXI 02 AT rear panel connections and front panel controls. The 
following topics are covered:

•	 Mounting

•	 Rear Panel Connections

•	 Front Panel Features

•	 Reset Modes

Mounting
The 1U high, eighth-rack width, 4.42-inch deep AXI 02 AT mounts in the following manners:

•	 Rack mounting — Attach the device to a standard 19 inch rack shelf. The following 
Underwriters Laboratories (UL) guidelines pertain to the installation of the AXI 02 AT in a 
rack:

•	 Reduced air flow — Install the equipment in the rack so that the amount of air 
flow required for safe operation of the equipment is not compromised.

•	 Mechanical loading — Mount the equipment in the racks so that uneven 
mechanical loading does not create a hazardous condition.

•	 Circuit overloading — When connecting the equipment to the supply circuit, 
consider the effect that circuit overloading might have on overcurrent protection 
and supply wiring. Consider equipment nameplate ratings when addressing this 
concern.

•	 Reliable earthing (grounding) — Maintain reliable grounding of rack-
mounted equipment. Pay particular attention to power supply connections other 
than direct connections to the branch circuit (such as the use of power strips).

•	 Under-furniture mounting — Mount the AXI 02 AT under the surface of a desk, 
table, or podium.

•	 Free-standing — Set the AXI 02 AT on furniture as desired.

NOTE:	 To mount the AXI 02 AT using an Extron ZipClip 100 mounting kit, see the 
instructions provided with the kit.
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Rear Panel Connections

OUTPUTS

1 2
1/2

S/PDIF

A B

A	 Analog Audio Outputs

B	 S/PDIF Audio Output

Figure 2.	 AXI 02 AT Rear Panel Connections

A  Analog Audio Outputs — Use a 6-pole or 3-pole, 3.5 mm captive screw connector 
to connect two balanced or unbalanced mono line level devices. Balanced or 
unbalanced stereo devices can also be connected using a 5-pole or 6-pole captive 
screw connector.

Tip

Sleeve
Tip

Sleeve

Tip

Sleeve
Ring

Tip

Sleeve
Ring

6-pole Audio OUTPUT Wiring
Balanced Output Unbalanced Output

NO Ground Here

NO Ground Here

	 3-pole Audio OUTPUT Wiring
Unbalanced Output

Tip

Sleeve
NO Ground Here

Balanced Output

Tip

Sleeve
Ring

Figure 3.	 6-pole and 3-pole Audio Output Wiring

ATTENTION:

•	 For unbalanced audio outputs, connect the sleeves to the ground contact.  
DO NOT connect the sleeves to the negative (-) contacts.

•	 Pour l’audio asymétrique, connectez les manchons au contact au sol. NE 
PAS connecter les manchons aux contacts négatifs (–).

NOTES:

•	 Balanced or unbalanced stereo sources can be connected with 6-pole 
connectors.

•	 When using a 5-pole CSR adapter, connect it so the far left plug is inserted 
into the far left jack of the 6-pole output.

B  S/PDIF Audio Output — Two S/PDIF output channels mirror the analog outputs on a 
coaxial RCA connector. Attenuation applied to the analog outputs does not affect the  
S/PDIF output.

2  

3  
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Front Panel Features

AXI 02 AT

CONFIGR

®

A C BD

A	 Power LED Indicator

B	 USB Config Port

C	 AT (PoE) Port

D	 Reset Button

Figure 4.	 AXI 02 AT Front Panel Controls

A  Power LED Indicator — This green LED blinks during boot up and lights steadily 
when the AXI 02 AT is fully operational. This LED also blinks amber for 10 seconds 
when the device receives a Dante identification signal (see Identifying a Physical 
Dante Device on page 22).

B  USB Config Port — Connect a computer to this USB Mini-B port for device 
configuration and firmware updates.

C  AT (PoE) Port — This RJ-45 port is used to connect the AXI 02 AT to a Dante 
network. The AT (PoE) port supports digital audio transport (AT), communication with 
the Dante network, communication with DSP Configurator for device configuration, and 
power over Ethernet (PoE).

ATTENTION:

•	 Power over Ethernet (PoE) is intended for indoor use only. It is to be 
connected only to networks or circuits that are not routed to the outside 
plant or building.

•	 L’alimentation via Ethernet (PoE) est destinée à une utilisation en intérieur 
uniquement. Elle doit être connectée seulement à des réseaux ou des 
circuits qui ne sont pas routés au réseau ou au bâtiment extérieur.

•	 If not provided with a power supply, this product is intended to be supplied 
by a UL Listed power source marked “Class 2” or “LPS” and rated output 48 
or 56 VDC (PoE), minimum 0.35 A.

•	 Si ce produit n’est pas fourni avec une alimentation, il doit être utilisé avec 
une source d’alimentation certifiée UL de classe 2 ou LPS avec une tension 
nominale de 48 Vcc ou 56 Vcc (PoE), un de 0,35 A minimum.

D  Reset Button — Using a stylus or small screwdriver, press and release this button 
to reset the unit to different tiers of factory defaults, including Dante settings such as 
device name, IP address, channel names, and audio format (see Reset Modes below).

4  
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Reset Modes
Press the front panel RESET button (see figure 4, D on page 5) with a stylus or Extron 
Tweeker to restart the Dante module in the AXI and leave all  other settings unaffected (see 
Command and Response Table for SIS Commands on page 30 for the command to 
reset output attenuation and preset data).

To cause an absolute system reset of the Dante module back to factory default conditions, 
press and hold the front panel reset button for 10 seconds until the AT (PoE) port LEDs 
flash. Following this reset, the Dante module will proceed to its normal boot sequence. This 
reset will:

•	 Set the IP configuration to default settings

•	 Clear all audio channel routing

•	 Set the Dante device name and channel names to default
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DSP Configurator 
Software

In addition to front panel hardware controls, the AXI 02 AT can be configured with Extron 
DSP Configurator Software and a PC running Microsoft® Windows® 7 or newer. This section 
describes Extron DSP Configurator Software and covers the following topics:

•	 Downloading and Installing DSP 
Configurator Software

•	 DSP Configurator Software 
Workspace

•	 Accessing the DSP Configurator Help 
File

•	 Menu Bar 
•	 Analog Outputs

Downloading and Installing DSP Configurator Software
1.	 From www.extron.com, click the Download tab (see figure 5, 1).

On the left sidebar, click the DSP Configurator Software link (2).

1

2

Figure 5.	 DSP Configurator Software Link on Download Page

On the DSP Configurator Software page, click Download (see figure 6, 1).

111

Figure 6.	 DSP Configurator Software Download Page

2.	 From the Download Center page, DSP Configurator Software should begin 
downloading automatically. If it does not, select click here in the top-left of the page.

NOTE:	 An Extron Insider account is required to download DSP Configurator 
Software and other software available from the Extron website. Login or account 
creation may be required before the Download Center page appears.

3.	 Select Run at the bottom of the page to run the DSP Configurator Software installer or 
select Save to save the install file to run at a later time.

5  

6  
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Accessing the DSP Configurator Help File
DSP Configurator Software comes loaded with a context-sensitive help file that can 
be accessed by clicking the help icon ( ) in the top right corner of any dialog box in 
DSP Configurator. Alternatively, click Help > Contents in the menu bar at the top of 
the main workspace, or press <F1> on your keyboard. This help file contains detailed 
procedures and further instruction on using all DSP Configurator Software features.

DSP Configurator Software Workspace
The DSP Configurator Software workspace for the AXI 02 AT contains a menu bar for 
accessing configuration tools and the main audio workspace for audio configuration (see 
figure 7).

Figure 7.	 DSP Configurator Software Workspace

Menu Bar

File

1  New — Opens a new configuration file. If the current 
configuration has not been saved, the Save dialog 
box opens and asks to save the current configuration 
before the new configuration is opened. Click Yes 
to save the current configuration before opening the 
new one. Click No to delete the current configuration 
before opening the new one. Click Cancel to return 
to the current configuration.

2  Open — Opens an existing configuration or template 
file. When selected, the Browse dialog box opens 
to search for saved configuration or template files. 
Double‑click a configuration or template file to load it.

NOTE:	 Configuration files have a .EDC file extension and template files have a 
.EDCT file extension.

7  
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3  Save — Saves the current configuration to a configuration file. If this is the first time the 
configuration has been saved, the Save Configuration As... dialog box opens. 
Enter a name and choose a save location for the configuration file.

4  Save As — Saves the current configuration file under a new name and location or as a 
template file. When selected, the Save Configuration As... dialog box opens.

5  Export Single Device — Saves the currently selected device configuration in 
Device Manager as a configuration file. This can be used to save an individual device 
configuration when there are multiple devices in Device Manager (see the Device 
Manager topic of the DSP Configurator Help file).

6  Recent Files — Lists the five most recently opened configuration files. These files can 
be selected and loaded into DSP Configurator Software.

7  Exit — Closes DSP Configurator Software. If the current configuration has not 
been saved, the Save dialog box opens and prompts the user to save the current 
configuration before closing the software. Click Yes to save the file. Click No to exit the 
application without saving. Click Cancel to return to the main workspace and keep the 
software running.

Edit

1  Cut — Removes the configuration of selected elements 
in the workspace to be pasted to other elements. 
Configuration data is not removed from the elements until it 
is pasted to other elements.

2  Copy — Copies the configuration of selected elements in 
the workspace to be pasted to other elements.

3  Paste — Applies the cut or copied configuration of elements to the selected elements 
in the workspace.

View

1  Meter Bridge — Opens a meter bridge to view 
input and output activity. The meter bridge is a 
floating window, allowing the user to work in the 
DSP Configurator Software workspace while 
simultaneously monitoring input and output activity.

NOTE:	 The meter bridge is only available in Live mode.

2  Re-enable All Dialogs — This option re-enables all dialog boxes that no longer 
appear based on user selection (certain dialog boxes that appear are user-defeatable by 
selecting a checkbox that reads Do Not Show This Dialog Again).

1

2

3

1

2
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Tools

1  Presets — Contains a submenu to mark 
and clear all elements in the main workspace 
as well as an option to save marked 
elements to a preset (see Presets on 
page 11).

2  Connect to/Disconnect from Device 
— When in Emulate mode, this option 
reads Connect to Device and opens 
the Connect to Device... dialog box 
(see Connecting Live to a Device on 
page 12). When in Live mode, this reads 
Disconnect from Device and returns the 
software to Emulate mode.

3  Device Manager — Opens the Device Manager dialog box. Click the help icon  
( ) in the top right corner of the dialog box to view the Device Manager topic for 
more information on using the Device Manager.

4  Issue RESET Command — Clears all gain settings, attenuation settings, and presets for 
the AXI. This command does not reset general settings such as device name or Dante 
network configuration.

5  Firmware Loader — Opens the Firmware Loader application if it is installed (see 
the Firmware Loader Help file for help updating firmware). Visit www.extron.com to 
download Firmware Loader.

6  Device Settings — Opens the Device Settings dialog box to edit the device 
name and view the network configuration. Click the help icon ( ) in the top right corner 
of the dialog box to view the Device Settings topic for more information.

7  Options — Opens the Options dialog box to configure DSP Configurator Software 
appearance and default settings. Click the help icon ( ) in the top right corner of the 
dialog box to view the Options topic for more information.

8  Network Audio Control — Opens Dante Controller by Audinate for routing audio 
over a Dante network (see Dante Controller on page 15). Dante Controller must be 
installed in order for the application to be opened. Visit www.extron.com to download 
Dante Controller.

Window

1  Cascade — Organizes windows by 
cascading them in the same order they were 
opened.

2  Close All Windows — Closes all open 
windows, leaving only the main workspace 
visible. When windows are closed, changes 
to any of the parameters in the open 
windows are saved before the windows are closed.

3  List of Open Windows — Below the dividing line in the menu is a list of all open 
windows. Select a window from the list to bring it into focus and to the forefront of the 
workspace. Windows appear in the order they were opened.

1

2

3

4

5

6

7

8
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Help

1  Contents — Opens the DSP Configurator Help file where 
detailed information about DSP Configurator Software can 
be found.

2  Search — Opens the DSP Configurator Help file with the 
Search field in focus.

3  About — Opens a window displaying software 
version number, copyright information, and part number for the installed copy of 
DSP Configurator. Click the Details button for a list of advanced details, such as build 
number.

Presets

The Presets drop‑down menu at the top of the main workspace allows the user to view 
and recall presets saved in the current configuration file or on a device connected in Live 
mode. When connected to the AXI in Live mode, presets with an asterisk next to them are 
stored on the AXI but are not in the current configuration file. Recall a preset to load it into 
the configuration file so it can be saved.

Figure 8.	 Presets Drop-Down Menu

After selecting a preset from the list, the affected processors are highlighted in green. 
Choose one of the following actions from the DSP Configurator status panel (see figure 9):

•	 Recall — Recalls and applies the selected preset configuration to the processors 
highlighted in green.

•	 Cancel — Cancels the preset recall and returns to the main workspace with the current 
configuration intact.

•	 Delete — Deletes the selected preset from the configuration.

Figure 9.	 Preset and Action Selection

Live and Emulate Panel
The Live and Emulate buttons allow users to switch between Live and Emulate modes in 
DSP Configurator Software.

Figure 10.	 Live and Emulate Panel

Emulate Mode

When a device is selected from the splash screen drop-down menu, DSP Configurator 
opens in Emulate mode. While in Emulate mode, DSP Configurator is functioning in an 
“offline” state. Changes made to the configuration file are not applied to a device. Creating 
configuration files in Emulate mode saves time by not requiring a device to be connected or 
present in order for the bulk of configuration to be completed.

1

2

3

8  

9  

10  
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In Emulate mode, the user can create configuration files and presets as though a device 
was connected, except for any actions that require a direct connection to the device or 
information that is stored only on the device. Once the offline configuration is complete, the 
user can either switch to Live mode and push the configuration to the device, or save the 
configuration file to be loaded onto one or multiple devices at a later time.

NOTE:	 Not all menu options or actions are available in Emulate mode.

Live Mode

Connect to a device in Live mode to push or pull configurations between the device 
and the host PC. In Live mode, changes made in DSP Configurator are directly applied 
to the connected device. Upon leaving Live mode, the user is asked to confirm that 
DSP Configurator should disconnect from the device.

Connecting Live to a Device
1.	 Click the Live button in the menu bar of DSP Configurator (see figure 11, 1). 

Alternatively, select Tools>Connect to Device or press <F6> on the keyboard. The 
Connect to device dialog box opens.

1

Figure 11.	 Live Button

NOTE:	 Select Connect... from the splash screen drop-down menu to connect to 
a device and start DSP Configurator in Live mode.

Connect to the AXI using one of the following connection types:

2.	 Dante — Click the Dante tab in the dialog box. Select the device from the 
Dante Devices list. If the device has not been named, the default name consists of 
the device model and the last 6 characters of the device MAC address (for example, 
AXI02-0a690b).

NOTE:	 The Dante device and control computer must be on the same network.

3.	 USB — Click the USB tab in the dialog box. Select the device from the USB Devices 
drop-down menu.

NOTE:	 The host PC must be connected to the USB Config port.

When a connection with the device is established, the Synchronize with Device 
dialog box opens. From the dialog box, one of two options can be selected:

Figure 12.	 Synchronize with Device Dialog Box

11  

12  
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a.	 Pull — Pulls DSP configuration and preset name data from the device and 
displays it in the DSP Configurator workspace. Pulling a configuration overwrites 
the current configuration file open in DSP Configurator.

b.	 Push — Pushes the DSP configuration and preset data from the current 
configuration file to the connected device. Pushing a configuration file overwrites 
any configuration and presets currently on the device.

4.	 Click the Advanced... button to open the Advanced Push Options dialog box. 
There are two options to choose from.

•	 Default — Pushes the entire configuration file including preset data.

•	 Custom — Allows the user to push the configuration only, all presets only, or 
selected presets only.

NOTE:	 If only pushing selected presets, the preset selection dialog box appears 
after clicking OK in the Advanced Push Options dialog box.

5.	 Click OK. When the push or pull is completed, Current State is displayed in the 
DSP Configurator status panel and the device is ready for further configuration.

Disconnecting from a Device
1.	 Click the Emulate button in the DSP Configurator Software menu bar (see figure 13, 

1). Alternatively, select Tools  >  Disconnect from Device or press <F6> on the 
keyboard.

1

Figure 13.	 Emulate Button

Click OK to confirm (see figure 14, 1).

111

Figure 14.	 Confirm Disconnect Dialog Box

13  

14  
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Analog Outputs
The AXI 02 AT has two AT Inputs and two analog outputs. The AXI analog outputs receive 
signal from the Dante network and are listed on the Dante network as Receiver channels.

Renaming AT Input Channels
AT Input channel names are read from the AXI Dante interface Receiver channel labels but 
can be changed from the DSP Configurator workspace while connected in Live mode. AT 
Input channel name changes made in DSP Configurator are reflected in Dante Controller 
and AT Input name changes made in Dante Controller are reflected in DSP Configurator.

NOTE:	 AT Input channel names can only be viewed or renamed when connected live to 
the device. Default names are always shown when in Emulate mode.

To rename an analog output channel:

1.	 Click the output name, the box becomes a text field with a flashing cursor.

2.	 Highlight or delete the text and enter the desired name.

3.	 Press <Enter> on the keyboard or navigate away from the text field to apply the new 
name. 

4.	 Press the <Down Arrow> key to navigate to and highlight the next name field.	

Attenuation Dialog Box

Double‑click an output attenuation block ( ) to open the Attenuation dialog box to 
configure output attenuation settings.

1  Output Name — This name matches the default or user 
defined AT Input/Dante Receiver channel name.

2  dBFS Meter — In Live mode, this meter displays the output 
signal level in dBFS ranging from -60 dBFS to 0 dBFS. Once 
the signal reaches or exceeds -1 dBFS (default) or the clip 
threshold defined in the Options dialog box, the clip box 
located at the top of the meter lights red. A numerical readout 
of the output level is located below the meter.

3  Output Attenuation Fader — Click and drag the fader 
to adjust the attenuation level in 1 dB steps. Click the fader 
once and press the <Up Arrow> or <Down Arrow> keys 
to adjust the attenuation in 1 dB steps. Use the <Page Up> 
or <Page Down> keys to adjust attenuation in 10 dB steps. 
Attenuation is not applied to the S/PDIF output.

4  Output Attenuation Text Box — Allows the user to 
enter an attenuation value in 1 dB steps. The value must be a 
negative number.

5  Mute Button — Mutes the signal at the post-meter output 
stage. When the button is red, mute is engaged.

6  OK Button — Confirms changes made to the contained parameters and closes the  
Attenuation dialog box.

7  Cancel Button — Reverts any changes made to the contained parameters back to 
their states when the current instance of the Attenuation dialog box was opened and 
closes the dialog box.

8  Attenuation Help Button — Opens the Output Attenuation topic of the 
DSP Configurator Help file for further assistance in configuring output attenuation.
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Dante Controller

This section discusses Dante Controller, the software used to configure a Dante network 
and route audio between Dante-enabled devices on the sae network. The following topics 
are discussed:

•	 Downloading and Installing Dante Controller

•	 AXI Network Configuration in Dante Controller

•	 Physical Dante Network Setup

•	 Dante Controller Operation

Downloading and Installing Dante Controller
Dante Controller from Audinate is required to select and route digital inputs and outputs 
to connected Dante‑enabled devices and for network configuration of the device. Install 
Dante Controller on a PC running Microsoft® Windows® 7 or newer. For full details about 
computer requirements, see the Dante Controller product page at www.extron.com.

To download Dante Controller:

1.	 From www.extron.com, click the Download tab (see figure 15, 1). 

2.	 On the left sidebar, click the Dante Controller link (2). 

The Dante Controller page opens (see figure 16 on page 16).

Figure 15.	 Accessing the Dante Controller Download Page

3.	 On the Dante Controller page, click Download (see figure 16, 1 on page 16).

The Download Center page opens (see figure 17 on page 16).

15  
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Figure 16.	 Dante Controller Page

4.	 On the Download Center page, click the Download dantecontroller.exe button 
and follow the prompts to download or run the Dante Controller installer file. If you 
choose to save the file for later installation, note the location.

Figure 17.	 Download Center, Dante Controller File

5.	 If you choose to run the file, follow all prompts. 

If you saved the file, double‑click the saved file to begin installation when ready. 

16  
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AXI Network Configuration in Dante Controller
Use a standard Ethernet cable to connect the AXI 02 AT to a network via the front 
panel AT (PoE) port (see figure 4, C on page 5) and power the device. Launch the 
Dante Controller software.

Dante Controller auto-discovers all Dante devices on the network and advertises itself to 
allow communication over the network.

Device Name
In Dante Controller, a device can be renamed to identify the device on the audio network 
(see Renaming the AXI 02 AT in Dante Controller on page 18 on the next page). The 
default device name consists of the model name, followed by the last six characters of the 
Dante device MAC address (for example, AXI02-801427).

When multiple devices are on the network with default device names, identifying a specific 
device is difficult. To avoid confusion and difficulty, Extron strongly recommends the 
following steps are taken:

•	 Connect devices to the Dante network one at a time.

•	 Rename each device before making audio subscriptions in Dante Controller.

•	 Rename each device with a unique and meaningful identifier.

•	 Rename each device before the next device is connected to the Dante network.

Receiver and Transmitter Names
In addition to renaming a device, individual Transmitter and Receiver channels can be 
renamed in Dante Controller. Rename Transmitter and Receiver channels to reflect the 
location of the device or the purpose of the Transmitter or Receiver.

Dante Controller Naming Conventions
•	 Device names follow Domain Name System (DNS) hostname rules. Legal characters are 

A-Z, a-z, 0-9, and hyphen (-). Names must begin with a letter and cannot begin or end 
with a hyphen (-).

•	 Dante Tx and Rx channel names (also known as labels) can be up to 31 characters 
in length. Channel labels are not case sensitive. For example, “ANALOG OUT-1” 
and “analog out-1” are recognized as the same name. Unicode and non-roman 
characters are not supported.

•	 Tx and Rx channel labels can use any character except equals (=), period (.), or @.

•	 Tx and Rx channel labels must be unique on a device but do not need to be unique on 
the network.
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Renaming the AXI 02 AT in Dante Controller

NOTE:	 Dante device naming can also be done via DSP Configurator (see 6 under 
Tools on page 10).

1.	 Ensure that the host PC and the AXI are connected to the same network.

2.	 From the control computer start menu select: 
All Programs>Audinate>Dante Controller>Dante Controller.

The Dante Controller - Network View screen opens. All Dante devices on the 
network are discovered and listed.

3.	 From the Device menu, select Device View or press <Ctrl+D>  on the keyboard (see 
figure 18).

Figure 18.	 Opening Device View

The Dante Controller - Device View dialog opens. Select the device being 
configured from the (Select a Dante Device...) drop‑down (see figure 19, 1).

Figure 19.	 Device View and Select a Dante Device Drop-Down

NOTE:	 If there are multiple AXI devices connected to the network that have not 
been renamed, obtain the Dante device media access code (MAC) address of 
the desired device from the white label on the right side of the device (when 
viewed from the front) in order to identify it in Dante Controller.

The Device View dialog populates with the selected AXI information.

Figure 20.	 Populated Device View Dialog Box

4.	 Click the Device Config tab (see figure 21, 1 on page 19) to open the Device 
Config page.

5.	 In the Rename Device panel, enter the new name of the device in the text field. No 
spaces are allowed in the name. Names should be significant identifiers. For example, 
enter AXI02-Breakout1 (2).

6.	 Click Apply (3). A confirmation prompt opens.

18  
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Figure 21.	 Device Config Dialog, Rename Device

7.	 Click Yes (figure 22, 1) to confirm the new name, then close the Device 
Configuration dialog box. The new name is written to the AXI. Repeat as necessary 
for all devices.

NOTE:	 The device name assigned in Dante Controller also applies to the device 
name recognized in DSP Configurator Software.

Figure 22.	 Rename Device Confirmation Dialog Box

21 
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Renaming a Receiver or Transmitter
In addition to renaming devices, individual Receiver and Transmitter channels can be 
renamed in Dante Controller. To better organize channels on the Dante network, it is 
recommended each channel be named using a description of the device they belong to, the 
location of the device, or the purpose of the channel.

To view the Receiver or Transmitter channels in Dante Controller, click the + sign next to the 
Receiver or Transmitter device name to expand it. The + sign becomes a - sign when the 
device is expanded (see figure 23, 1).

NOTE:	 The AXI 02 AT does not have any Transmitter channels.

Figure 23.	 Expanded Receivers and Transmitters

23 	
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Renaming a Receiver

The default names shown in the Dante Receivers column are extracted from the 
connected Dante device (2). The AXI Receivers are labelled Analog-S/PDIF Out 1 and 
Analog-S/PDIF Out 2 because the analog outputs receive signal from the Dante network 
and that signal is also mirrored to the S/PDIF output.

To rename an AXI Receiver:

1.	 From the Device menu on the Network View screen, select Device View, or press 
<Ctrl+D> on the keyboard. The Device View dialog box opens.

2.	 From the (Select a Dante Device...) drop-down menu, select the name of the 
desired AXI device (see figure 24, 1).

3.	 On the Device View screen, select the Receive tab (2).

4.	 Click the name of the Receiver to be renamed. The name becomes a text field with a 
cursor (3).

5.	 Enter the new name (up to 31 characters) using any combination of letters, numbers, 
and special characters except for @, =, and . (period).

6.	 Press <Enter> on the keyboard or click another channel name to confirm the new 
name.

7.	 Repeat steps 4 through 6 to rename additional Receiver channels.

8.	 When finished renaming Receivers, close the Device View dialog box.

Figure 24.	 Renaming a Receiver

24 	
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Finding a Dante Device IP Address
To find the IP address of a Dante device, the name of the device is needed (see Renaming 
the AXI 02 AT in Dante Controller on page 18).

NOTE:	 If the AXI has not been renamed, its default name consists of the product name 
followed by a hyphen, plus the last 6 characters of the Dante device MAC address 
(for example, AXI02-0a690b).

1.	 Open Dante Controller.

2.	 On the Dante Controller-Network View screen, click the Device Info tab (see 
figure 25, 1).

3.	 On the Device Info page, locate the name of the AXI device in the Device Name 
column (2). The IP address is located in the Primary Address column (3). In the 
example below, the IP address for the connected AXI 02 AT is 192.168.11.181.

Figure 25.	 Device Info Page

Identifying a Physical Dante Device
If an AXI 02 AT has not been renamed (see Renaming the AXI 02 AT in Dante Controller 
on page 18) and the MAC address cannot be located to identify the device within Dante 
Controller, it is possible to physically identify a device using the software.

1.	 On the Dante Controller - Network View screen,  
select Device>Device View from the toolbar. The Dante 
Controller - Device View dialog box opens. 

2.	 Select a device from the (Select a Dante Device...) 
drop‑down list. The Device View dialog box populates with information from the 
selected AXI.

3.	 To identify the AXI, click the Eye icon (see the figure to the right) on the 
Device View screen toolbar. The power LED on the front panel of the selected 
device blinks amber (see figure 4, 1 on page 5).

25  
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Physical Dante Network Setup
A physical network is required to share Dante audio channels among Dante-enabled 
devices like the AXI 02 AT. Other devices capable of sending and receiving audio over a 
Dante network must be on the same physical network in order to communicate via Dante 
(see figure 26 for an example of a physical Dante network).
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Figure 26.	 Physical Dante Network Diagram

Dante Controller Operation
Dante Controller is used for all network signal routing of Transmitters and Receivers for 
Dante-enabled devices. The analog output and mirrored S/PDIF channels of the AXI 02 AT 
are shown in Dante Controller as receivers, and are available in Dante Controller for routing 
with other Dante devices.

Dante Transmitters and Receivers
A Dante network is comprised of transmitters that output digital audio onto the Dante 
network and receivers that receive digital audio input from the Dante network.

AXI Transmitters and Receivers

The AXI 02 AT does not have any Dante Transmit channels.

The AXI 02 AT analog outputs are listed as Dante receivers because they receive digital 
audio from the Dante network and output that signal as analog audio via the analog outputs. 
Signal received by the analog outputs from the network is also mirrored to the S/PDIF 
output.
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Routing Device Channels
In order for the AXI to receive audio from the network, audio subscriptions must be 
established between the AXI and other Dante devices on the audio network. Audio 
subscriptions are managed using the Dante Controller Network View page and the 
Routing tab (see figure 27 on page 25). The transmitters, listed horizontally along the 
top of the screen, and the receivers, listed vertically down the left side, form a matrix whose 
intersections are the connection points between the transmitters and receivers.

•	 To make the receiver-to-transmitter subscription (connection), click once on an 
intersection. Once a subscription has been made, the corresponding subscription icon 
will appear.

NOTE:	 AXI 02 AT supports up to two receive flows (unicast or multicast). Refer to 
the Dante Controller User Guide for more information on flows.

•	 To remove a subscription, click on the icon at the intersection.

One of the following icons appears at each subscription intersection, indicating the status of 
both the transmitter and receiver channels and the subscription: 

Icon Description

Indicates an active subscription.

Indicates a pending subscription.

Indicates a broken subscription.

Indicates the transmitting device has been removed from the network or is 
switched off.

See the Dante Controller User Guide, available at the Audinate website, for additional 
information.

Creating Subscriptions Between Transmitters and Receivers

1.	 Ensure the host PC and AXI are connected to the same network.

2.	 From the start menu select: 
All Programs > Audinate > Dante Controller > Dante Controller 

The Dante Controller - Network View screen opens.

Dante Controller auto-discovers Dante devices on the network and advertises itself to 
allow other Dante-enabled devices to communicate with it. Transmitters connect to 
receivers using the connection matrix.
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Figure 27.	 Routing Tab of Network View Screen

3.	 To show the transmitters of a Dante device, click the + box next to the desired device 
in the Dante Transmitters panel, such as DMP128Plus-MainRack (see figure 27, 1 
above). The + converts to a – sign when the device expands.

4.	 To show the receivers of a Dante device, click the + box next to the desired device in 
the Dante Receivers panel, such as AXI02-Breakout1 (2).

5.	 Click the intersection of the desired transmitter and receiver (3). 

Example: DMP128Plus-MainRack EXP_Out-01 is routed to the AXI02-Breakout1 
Analog-S/PDIF Out 1.

A check mark at the intersection indicates the subscription is made. A check mark also 
appears next to the receiver channel.

Disconnecting Inputs from Outputs
To remove a subscription, click the intersection between the receiver and the transmitter.

NOTE:	 After making changes to Dante network routing such as connections 
(subscriptions), device names, or channel labels, wait at least 5 seconds before 
disconnecting or powering down the devices. This ensures that the new information 
is properly saved to those devices. Device level configuration such as sample rates, 
latency, and clock settings are saved instantly.

Dante Troubleshooting
The most common Dante troubleshooting issues occur when devices are not discovered by 
the Dante Controller software, or routing is not successful. Both issues occur when software 
is not able to properly discover devices operating on the Dante network.

Before moving into more difficult troubleshooting, shut down Dante Controller and reseat the 
Ethernet cable connecting the host PC to the Dante network and restart Dante Controller. 
This can be enough for the software to reacquire the Dante network.

If the problem persists, perform the following troubleshooting procedures in the order 
presented.
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Simplifying the Network for Troubleshooting
If further troubleshooting of Dante discovery is necessary, begin by simplifying the network:

1.	 Bypass network switches by connecting two Dante-compatible units, such as an 
AXI and a DMP 128 Plus AT, via their AT ports.  

2.	 Connect the PC to an unused AT port with an Ethernet cable.

3.	 Use Dante Controller to check if the issue was resolved before moving on to network 
interface troubleshooting.

4.	 If the issue is resolved, add connections and hardware one at a time, checking for 
proper operation after each addition, until the point of failure is discovered (typically a 
bad cable or invalid redundant configuration).

Troubleshooting the Network Interface
If the issue is still present, continue to diagnose the PC network connections as described 
below. Check Dante Controller after each step to see if the problem is resolved.

1.	 Open the Configure Dante Interface dialog box by clicking the Choose a Dante 
Interface icon (see figure 28, 1).

Figure 28.	 Choose a Dante Interface Icon

Be certain the correct LAN connection is selected (the PC LAN port that is physically 
connected to the Dante network) and note the IP address.

Figure 29.	 Configure Dante Interfaces Dialog Box

2.	 If it is on, turn off the PC wireless adapter. Disable all connections except the LAN 
port connected to the Dante network (verify this is the correct port by checking the IP 
address shown in step 1).

3.	 Turn off all anti-virus and firewall software on the computer.

4.	 Enable DHCP on the remaining network connection. This forces the computer to 
acquire an IP address from the Dante network.

28  
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Restarting Dante Controller
If subscriptions or normal operation cannot be restored, restart Dante Controller software 
(see the Dante Controller Help file for the procedure). To access the Dante Controller Help 
file, do any of the following:

•	 Click the Help icon in the upper-right corner of the Dante screen (see figure 30, 1).

•	 Select Contents from the Help menu (2) on the Dante screen.

•	 Press the <Shift+F1> keys on the computer keyboard.

Figure 30.	 Accessing the Dante Help File

30  
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Remote Control

This section discusses the Simple Instruction Set (SIS™) commands that can be issued to 
the AXI 02 AT via the front panel USB Config port. The following topics are discussed:

•	 SIS Commands

•	 Command and Response Table for SIS Commands

•	 DSP Configurator Software Workspace

•	 Command and Response Table for DSP SIS Commands

SIS Commands
Simple Instruction Set (SIS) commands are a set of commands developed by Extron that 
consist of one or more characters per field and do not require any special characters to 
begin or end a command sequence. When the AXI 02 AT determines a command is valid, 
it executes the command and sends a response to the host device. All responses from 
the device to the host end with a carriage return and a line feed, indicating the end of a 
response string (one or more characters).

The AXI can be configured and controlled via SIS commands sent through the front panel 
USB Config port (see figure 4, B on page 5). SIS commands are entered from a host 
PC via the DataViewer software application which can be downloaded from  
www.extron.com (see the DataViewer Help file to use this program).

Using the Command and Response Tables
When programming, certain characters are more conveniently represented by their 
hexadecimal rather than ASCII values. The table below shows the hexadecimal equivalent of 
each ASCII character:

•

Space

l

I

ASCII to HEX  Conversion Table

Figure 31.	 ASCII to HEX Conversion Table

The Command and Response tables list valid ASCII commands, the AXI 02 AT responses 
to the host, and descriptions of the command functions with the results of executing the 
commands.
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Verbose Mode
A USB connection is used to monitor changes that occur on the AXI 02 AT. For a session 
to receive change notices, the device must be set to verbose mode 1 or 3. In verbose 
mode 1 or 3, the device reports changes in messages that resemble tagged SIS command 
responses.

NOTES:	

•	 If tagged responses are enabled (verbose modes 2 and 3), all “query” and “view” 
commands return the constant string and the value.  
For example, a tagged response to a part number query (N) would return 
PnoX!]. An untagged response would only return X!].

•	 Set command responses are always tagged.

Symbol Definitions

] = Carriage return (with line feed)

} = Carriage return (no line feed)

• = Space character

| = Pipe (can be used interchangeably with the } character)

E = Escape key

W = Can be used interchangeably with the E character

NOTES: 

•	 Only instances marked with a • character require a space. Any spaces between 
characters in the command and response tables are only used for ease of 
reading.

•	 Unless stated otherwise, SIS commands are not case sensitive.

Error Responses
When the device is unable to execute the command, it returns an error response to the 
host. The error response codes and their descriptions are as follows:

E10 — Unrecognized command E17 — Invalid command for signal type

E11 — Invalid preset number E18 — System/command timed out

E12 — Invalid port number E22 — Busy

E13 — Invalid parameter E24 — Privilege violation

E14 — Not valid for this configuration E25 — Device not present
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Command and Response Table for SIS Commands

Command ASCII Command 
(host to  unit)

Response 
(unit to host)

Additional Description

General
Query part number N X!]

PnoX!]
(verbose 2 and 3 response)

Query firmware version Q X@]

Ver01*X@]
(verbose 2 and 3 response)

Query firmware version 
with patch

*Q X@]

Bld*X@]
(verbose 2 and 3 response)

Query detailed 
firmware version

0Q X1#]

Ver00*X1#]
(verbose 2 and 3 response)

Query embedded OS 
type and version

14Q {embedded OS version}]
Ver14*{embedded OS 
version}] (verbose 2 and 3 response)

Query firmware version 
with build

20Q x.xx.xxxxx-bxxx]

Ver20*x.xx.xxxxx-bxxx]

major.minor.patch-build
(verbose 2 and 3 response)

Set Verbose Mode EX1$CV} VrbX1$]
View Verbose Mode ECV} X1$]

VrbX1$]
(verbose 2 and 3 response)

System reset 
(factory default)

EZXXX} Zpx] Resets attenuation, and preset 
configuration. Network configuration 
is not affected.

Network Commands
Reboot Dante device EBEXPD} ExpdB] Reboots only the Dante interface. 

AXI device remains on during Dante 
reboot.

Query current status EKEXPD} X1^]

ExpdKX1^]
(verbose 2 and 3 response)

KEY:
X! = Device part number 60-1753-01

X@ = Firmware version n.nn or n.nn.nnnn (major.minor.patch)

X1# = Detailed firmware information <bootloader version>-<factory code version> -<updated code version>

X1$ = Verbose mode 0 = Clear/none 
1 = Verbose mode (default for USB) 
2 = Tagged responses for queries 
3 = Verbose mode and tagged responses for queries

X1^ = Device status POWERUP = Device is powering up			   POWERDOWN = Device is powering down 
READY = Device is ready					     BUSY = Device is busy 
COMM_ERROR = Communication error		 FIRMWARE_UPGRADING = Firmware is upgrading 
REBOOT_REQUIRED = Dante device reboot is required	 REBOOTING = Dante device is rebooting
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Command ASCII Command 
(host to  unit)

Response 
(unit to host)

Additional Description

Network Commands (continued)
Set DHCP on ED1EXPD} ExpdD1] DHCP must be off in order for this 

command to be accepted as valid 
(DHCP is enabled by default). Dante 
device must be rebooted for DHCP 
change to take effect.

View DHCP status EDEXPD} X1%]

ExpdDX1%]
(verbose 2 and 3 response)

Set Dante IP/subnet/
gateway

EIX#*X$*X%EXPD} ExpdIX#*X$*X%] Using this command automatically 
turns DHCP off. Dante device must 
be rebooted for new IP configuration 
to take effect (see the Reboot Dante 
device command in the section 
above).

View IP/subnet/
gateway

EIEXPD} X#*X$*X%]

ExpdIX#*X$*X%] (verbose 2 and 3 response)

View MAC address EHEXPD} X^]

ExpdHX^] (verbose 2 and 3 response)

View Dante device 
name

ENEXPD} X&]

ExpdNX&] (verbose 2 and 3 response)

View Dante channel 
name

EAX1)EXPD} X1)*X1!

ExpdAX1)*X1!] (verbose 2 and 3 response)

Presets
Recall Preset X( . RprX(]

KEY:

X# = IP address xxx.xxx.xxx.xxx
X$ = Subnet mask xxx.xxx.xxx.xxx
X% = Gateway IP xxx.xxx.xxx.xxx
X^ = MAC address xx-xx-xx-xx-xx-xx
X& = Dante device name Device names follow Domain Name System (DNS) hostname rules. Legal characters are 

A-Z, a-z, 0-9, and hyphen (-). Names must begin with a letter and cannot begin or end 
with a hyphen (-).

X( = Preset number 1-8
X1) = Channel number 1 or 2
X1! = Dante channel name Channel name may not contain = (hyphen), .(period), or @
X1% = DHCP status 1 = enabled (default), 0 = disabled
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DSP SIS Commands
Parameters such as attenuation and mute can be set using SIS commands. DSP SIS commands 
adhere to the following structure:

E <Parameter ID><OID>*<Value>AU}
In this structure, <Parameter ID> defines which parameter is being set (mute or attenuation), 
<OID> (Object ID) defines which input or output is being affected, and <Value> defines the mute or 
attenuation status with a numerical value. See the example command below:

EG60000*-12AU}
This command sets the G parameter (gain/attenuation) of OID 60000 (line output 1) to a value of 
-12 (-12 dB).

For a complete list of the analog output OID numbers and acceptable attenuation value ranges for 
each input and output, see Object ID (OID) Number and Value Range Tables on page 32.

Command and Response Table for DSP SIS Commands

Command ASCII Command 
(host to  unit)

Response 
(unit to host)

Additional Description

Attenuation
Set attenuation EGX1)*X1!AU} DsGX1)*X1!]
View attenuation EGX1)AU} X1!]

DsGX1)*X1!] (verbose 2 and 3 response)

Mute
Set mute EMX1)*X1@AU} DsMX1)*X1@]
View mute status EMX1)AU} X1@]

DsMX1)*X1@] (verbose 2 and 3 response)

KEY:

X1) = Object ID (OID) number See Object ID (OID) Number and Value Range Tables for Input and Output OID numbers.

X1! = Attenuation value See Object ID (OID) Number and Value Range Tables below for Input and Output OID numbers.

X1@ = Mute status 1 = muted, 0 = ummuted

Object ID (OID) Number and Value Range Tables

NOTES:	

•	 Attenuation values should be entered as negative integers.

•	 Attenuation values must be in 1 dB steps.

Output OID Attenuation Value Range

Output 1 60000 0 to -100

Output 2 60001 0 to -100



Contact Information

Worldwide Headquarters:  Extron USA West, 1025 E. Ball Road, Anaheim, CA 92805, 800.633.9876

Extron Warranty

Extron warrants this product against defects in materials and workmanship for a period of three years from the date 
of purchase. In the event of malfunction during the warranty period attributable directly to faulty workmanship and/
or materials, Extron will, at its option, repair or replace said products or components, to whatever extent it shall 
deem necessary to restore said product to proper operating condition, provided that it is returned within the warranty 
period, with proof of purchase and description of malfunction to:

USA, Canada, South America, 
and Central America:
Extron 
1230 South Lewis Street 
Anaheim, CA 92805 
U.S.A.

Asia:
Extron Asia Pte Ltd 
135 Joo Seng Road, #04-01 
PM Industrial Bldg. 
Singapore 368363 
Singapore

Japan:
Extron Japan 
Kyodo Building, 16 Ichibancho 
Chiyoda-ku, Tokyo 102-0082 
Japan

Europe:
Extron Europe 
Hanzeboulevard 10 
3825 PH Amersfoort 
The Netherlands

China:
Extron China 
686 Ronghua Road 
Songjiang District 
Shanghai 201611 
China

Middle East:
Extron Middle East 
Dubai Airport Free Zone 
F13, PO Box 293666 
United Arab Emirates, Dubai

Africa:
Extron South Africa 
3rd Floor, South Tower  
160 Jan Smuts Avenue  
Rosebank 2196, South Africa

This Limited Warranty does not apply if the fault has been caused by misuse, improper handling care, electrical 
or mechanical abuse, abnormal operating conditions, or if modifications were made to the product that were not 
authorized by Extron.

NOTE:	 If a product is defective, please call Extron and ask for an Application Engineer to receive an RA (Return 
Authorization) number. This will begin the repair process.

	 USA:	 714.491.1500 or 800.633.9876	 Asia:	 65.6383.4400 

	 Europe:	 31.33.453.4040 or 800.3987.6673	 Japan:	 81.3.3511.7655

	 Africa:	 27.11.447.6162	 Middle East:	 971.4.299.1800 

Units must be returned insured, with shipping charges prepaid. If not insured, you assume the risk of loss or damage 
during shipment. Returned units must include the serial number and a description of the problem, as well as the 
name of the person to contact in case there are any questions. 

Extron makes no further warranties either expressed or implied with respect to the product and its quality, 
performance, merchantability, or fitness for any particular use. In no event will Extron be liable for direct, indirect, or 
consequential damages resulting from any defect in this product even if Extron has been advised of such damage.

Please note that laws vary from state to state and country to country, and that some provisions of this warranty may 
not apply to you.
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